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Technical Support
You can obtain technical support for any Ixia product by contacting Ixia Technical Support by any of the
methods mentioned below.

Ixia sales office contact information (http://www.ixiacom.com/contact_us/map/) is available on the Ixia
website.

Corporate
Headquar-
ters

[[[Undefined variable
Company_Inform-
ation.Company_
Name]]] Worldwide
Headquarters

26601 W. Agoura Rd.

Calabasas, CA 91302

USA

+1 877 FOR IXIA (877
367 4942)

+1 818 871 1800
(International)

(FAX) +1 818 871 1805

sales@ixiacom.com

Web site: www.ixiacom.com

General: info@ixiacom.com

Investor Relations: ir@ixiacom.com

Training: training@ixiacom.com

Support: support@ixiacom.com

+1 818 595 2599

For the online support form, go to: http://www.ixi-
acom.com/support/inquiry/

EMEA [[[Undefined variable
Company_Inform-
ation.Company_
Name]]] Europe
Limited

Part 2nd floor,

Clarion House, Nor-
reys Drive

Maidenhead, UK SL6
4FL

+44 (1628) 408750

FAX +44 (1628)
639916

salese-
mea@ixiacom.com

Support: support-emea@ixiacom.com

+40 21 301 5699

For the online support form, go to: http://www.ixi-
acom.com/support/inquiry/?location=emea

Asia Pacific [[[Undefined variable
Company_Inform-
ation.Company_
Name]]] Pte Ltd

210 Middle Road

Support: support-asiapac@ixiacom.com

+91 80 4939 6410

For the online support form, go to: http://www.ixi-
acom.com/support/inquiry/
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#08-01 IOI Plaza

Singapore 188994
Japan [[[Undefined variable

Company_Inform-
ation.Company_
Name]]] KK

Nishi-Shinjuku Mitsui
Bldg 11F

6-24-1, Nishi-Shin-
juku, Shinjuku-ku

Tokyo 160-0023

Japan

Support: support-japan@ixiacom.com

+81 3 5326 1980

For the online support form, go to: http://www.ixi-
acom.com/support/inquiry/

India [[[Undefined variable
Company_Inform-
ation.Company_
Name]]] Technologies
Pvt Ltd

Tower 1, 7th Floor,
UMIYA Business Bay

Cessna Business Park

Survey No. 10/1A,
10/2, 11 & 13/2

Outer Ring Road, Var-
thur Hobli

Kadubeesanahalli Vil-
lage

Bangalore East Taluk

Bangalore-560 037,
Karnataka, India

+91 80 42862600

Support: support-india@ixiacom.com

+91 80 4939 6410

For the online support form, go to: http://www.ixi-
acom.com/support/inquiry/?location=india

China Ixia Technologies
(Shanghai) Company
Ltd

Unit 3, 11th Floor,
Raffles City, Beijing

Beijing, 100007 P.R.C.

Support: support-china@ixiacom.com

400 898 0598 (Greater China Region)

+86 10 5732 3932 (Hong Kong)

For viewing the FAQs related to the product, go to Ixia Technical Support Online: https://eb-
soprod.ixiacom.com/OA_HTML/jtflogin.jsp
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Getting Started with IxLoad

About this Guide
This section contains information that explains the typographical conventions used in this doc-
umentation. This information will aid you in using the documentation most effectively. Also provided is
a list of related documentation that you may find useful.

Conventions
The following typographical conventions are used in this documentation:

l Italics are used to indicate the names of software fields and parameters, titles of books or doc-
uments, and first references to words, terms, phrases, or concepts that have a special meaning or
require special identification or emphasis. For example:
n In the userid field, enter your assigned user identification number.
n Norton’s Telecom Dictionary is a helpful reference tool.
n The term tolerance level refers to the standard deviation setting.
n The variable n represents any numerical value.

l Menu names and options appear as bold blue text in online Help, and appear in small capital let-
ters in documents. For example:
n To save your input, choose the File>Save menu option.

l Bold black type is used to indicate the names of buttons, commands, and files that are part of pro-
cedures, as well as to identify field and parameter options. In addition, bold text emphasizes import-
ant information in text or in caution, warning, or danger statements. For example:
n To proceed to the next step, click OK.
n Use the copy command to duplicate the field entry.
n Save and close the books.xml file.
n Always save your test configuration.

l Courier text is used to indicate typed text input. For example:
n Access the new file name at the command line: c = newbook.gif.

n Enter the setup.ini location: setupini = Ixia\Code\New.

l PC keys are indicated in all caps, using the following conventions:
n Simultaneous keystrokes are shown by joining the key names with a plus sign (+), For

example, CTRL+Q.
n Sequential keystrokes are shown by joining the key names with a comma (,). For example,
SHIFT, F7.

Icons are used throughout the documentation to draw attention to caution, warning, and danger state-
ments. Icons also identify notes, important information, and the start of a procedure.

Provides information that is needed to avoid potential harm to equipment or the envir-
onment.

Provides information needed to prevent certain harm to a person, piece of equipment,
or the environment.

DANGER Provides information to prevent certain severe bodily harm to a person.

Provides information that needs special attention within text.

IMPORTANT Provides information that is especially important for correct product operation.
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Related Documentation
The following documentation may be helpful in gaining more understanding of IxLoad. The doc-
umentation is available from the Help pull-down menu in IxLoad or from the IxLoad CD.

Ixia user documentation is also available in the Support>User Guides area of ixiacom.com. User regis-
tration is required to view this online documentation.

l IxLoad User Guide
l IxLoad Tcl API Programming Guide

- 2 -
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Getting Started with IxLoad
If you are new to IxLoad, you can follow the procedures in this Getting Started guide to run a simple test
and quickly gain experience with IxLoad. If you need to do more advanced testing, you should refer to the
IxLoad User Guide.

The steps described in this guide are:

l Step 1: Install IxLoad
l Step 2: Connect the Ixia ports
l Step 3: Start IxLoad and Open the Sample Repository
l Step 4: View the Client and Server Networks
l Step 5: Display the Server and Client Traffic
l Step 6: View the Timeline and Objectives
l Step 7: Select Ports for the Test
l Step 8: Start the Test
l Step 9: View the Test Results
l Step 10: Save the Test Configuration

Requirements
To run the IxLoad tests in this guide, you need the following:

l An Ixia chassis with a load module that supports IxLoad (see the release notes for the current list)
l Two ports available on the load module
l A loopback (cross-over) cable or layer 2 switch
l A PC with one of the following versions of Windows installed:

n Windows Vista SP2 (32- or 64-bit)
n Windows 7
n Windows 8.1 Enterprise
n Windows 2008 Server (32- or 64-bit)
n Windows 2012 Server

Step 1: Install IxLoad
IxLoad is available for download on Ixia’s website.

The following installers are available:

l IxLoad_<version>.exe: Installs the IxLoad client.
l IxLoadChassis_<version>.exe: Installs the IxLoad components that must run on the Ixia
chassis.

l IxLoadMediaClips_<version>.exe: Installs the sample video files to be used for testing
video performance.

In the current release of the application, the IxLoad installer does not contain any soft-
ware prerequisites, such as the .NET framework or SQL Server Express, that are
required for the IxLoad application to run. If the PC you are installing IxLoad on does
not have the prerequisite software already installed, during the installation process you
will be prompted to provide a location for any of the missing prerequisites. You then
have the option of specifying a path on the local host (if you have them available as a kit
stored on your host), or you can choose to download them from the http://www.ixi-
acom.com/support/downloads_and_updates/prerequisites page on the Ixia website.
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You must install IxLoad in two locations:

l on the PC where you will run IxLoad
l on the chassis that you will use to generate IxLoad traffic

On the chassis, you must install IxOS before you install IxLoad. The IxOS components that IxLoad
requires are installed by default when you install IxOS; you do not have to select any optional com-
ponents during the IxOS installation. Refer to the IxLoad release notes for the specific version of IxOS
that this release of IxLoad requires.

The PC that you will use for the IxLoad client should have at least a 1.8GHz P4 CPU, 1GB of RAM, and a
screen resolution of 1024x768. The PC must have one of the versions of Windows listed under Require-
ments.

As part of the installation procedure, you will be asked to register IxLoad. You should ensure that you
have your IxLoad licenses ready before you begin installation. If you are unfamiliar with Ixia's product
licensing process, see IxLoad Licenses.

You can install multiple versions of IxLoad on the client and on the chassis. For
information on using multiple versions of IxLoad, see the IxLoad User Guide.

To install IxLoad, see Installing IxLoad.

Installing IxLoad

Prerequisites Required for Installation

IxLoad requires certain third-party components to be installed such as Microsoft DotNet 4 and Microsoft
SQL Server 2008.

If you are installing from a DVD, these components are located under a folder named prerequisites
in the root of the DVD. The installer will automatically locate and install the required components.

If the installer cannot automatically find the components under the prerequisites folder, it prompts
you to choose how to find the components:

l Automatically download... allows the installation to download the required components from
Ixia's website. This is the recommended option.

l Browse enables you to specify the directory where the components are located. If an Internet con-
nection is not available on the PC on which you are installing IxLoad, you can download the com-
ponents to another computer, share the location, and browse to that location.
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To install IxLoad:

1. On a PC or Ixia chassis, login under an account that includes Administrator privileges. If you run
the installation from an account that does not have Administrator privileges, the installer displays
the following error message:

Error installing ikernel.exe (0xa00)

2. The IxLoad installer consists of two files:
l The installer and first half of the file repository: IxLoad_<version>_EA.exe (or
EB.exe)

l The second half of the repository: IxLoad_<version>_EA.part1 (or EB.part1)
Both files must be in the same directory.

3. Double-click the installer .exe file to start the installation.
Apart from this, the installation is a typical InstallShield installation; respond to the prompts as
the installer displays them in the windows.

4. Click Finish to complete the IxLoad installation.
Remember to install IxLoad on the remaining system (chassis or PC) before you start to use it.

Step 2: Connect the Ixia ports
To run the tests described in this guide, you can use either of two test topologies:

l Ixia ports connected to a Layer 2 switch.
l Ixia ports connected directly to each other (back-to-back).

The figure below shows both topologies. Connecting the Ixia ports to a DUT would create a realistic test
scenario and results; connecting the Ixia ports directly to each other is simpler. Either one will work for
the purpose of getting to know IxLoad.

To connect the Ixia ports:

1. Choose the scenario you want to use, and then connect the Ixia ports.
2. On the IxLoad client PC, test your connection to the chassis by using the Ping command to ping

the management port on the chassis.

On an XM12 chassis, the management port is on the front of the chassis. On all other
chassis, it is on the rear.
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Step 3: Start IxLoad and Open the Sample Repository
Before you start IxLoad:

l Make sure IxServer is running on the chassis. IxServer normally starts automatically when Win-
dows starts or when a user logs on.

l Make sure that you know which ports are available on the chassis. Other Ixia applications such as
IxExplorer, IxAutomate, and Tcl scripts allow users to take ownership of ports on the Ixia chassis.
If IxLoad tries to use a port owned by another user, it will not be able to run the test.

To start IxLoad and open the sample repository:

1. Double-click the IxLoad icon (shown below).

IxLoad’s main window displays. IxLoad automatically logs you on using the local network name
configured on your PC. When you select Ixia ports for your test, IxLoad will use this name to
identify those ports as being reserved for your exclusive use.
When you start IxLoad for the first time, it opens a new repository. A repository is the file in which
IxLoad stores test configurations.
To perform the test described in this guide, you can use a pre-configured repository included with
IxLoad named simpleHTTP.rxf. simpleHTTP.rxf contains most of the elements required
to run a basic HTTP test.

2. On the File tab, click Open Repository.
3. Browse to the following directory:

<installPath>\Ixia\IxLoad\<version>\

and double-click the Samples.zip file to browse it.
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4. In the Samples.zip file, browse to the Repositories folder, and select the sim-
pleHTTP.rxf file.
IxLoad opens simpleHTTP.rxf.

Select the Test Overview node to display an overview of the test.

Step 4: View the Client and Server Networks
In IxLoad, a network determines the addresses of the hosts and their network configuration. An IxLoad
network consists of simulated subnets residing on one or more Ixia ports. For most applications that
you plan to use IxLoad for, you can think of networks as simulating LANs containing either clients or
servers.

The simpleHTTP.rxf repository includes client and server networks you can use for your testing. You
can accept the default entries for these networks or change them if necessary.

To view the default client and server networks:

1. In the Test Configuration node, select the client nettraffic (as shown below).

2. In the client nettraffic, select Client Network.
When you select Client Network, the area to the right of the Test Configuration node contains the
elements that define the properties of the network.
For example, the IP element defines the IP address ranges that will be used on the network. The IP
element defines the IP addresses to be used.
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3. Click each element to see the ranges that are configured.
For the network in simpleHTTP.rxf, there is one range of IP addresses and one range of MAC
addresses (see figure below). There is a range of VLAN tags configured, but they are disabled and
will not be used in this test .
Click each of the tabs if you want to view the parameters configured for them.

4. To view the server network, select the server network in the repository tree (see figure below).

5. Select Servers.
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As with the client network, the tabs to the right display the network parameters that define the server net-
work. The figure below shows how the network controls correspond to the test topology.
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Step 5: Display the Server and Client Traffic
In IxLoad, traffic is generated by Activities. An Activity defines the non-network properties of a traffic
stream, such as its protocol, its role in the connection (client or server), and the functions it performs,
such as executing commands (for an HTTP client) or serving pages (for an HTTP server).

SimpleHTTP.rxf includes one client activity and one server activity. The client activity simulates a
web browser and the server activity simulates a web server.

To display the server and client Activities:

1. In the Server column of the Scenario Editor, click the HTTP server activity.
The tabs on the bottom half of the window contain the controls used to configure the HTTP server
activity.
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2. Click the Web Pages tab.
The Web Pages tab lists HTML pages that the IxLoad HTTP server will offer.
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3. Select the HTTP client to display the HTTP client NetTraffic, then click the HTTP Client activity.

In the area to the right of the Navigation Tree, the tabs that define the client HTTP activity display.
These tabs define the attributes and functionality of the client HTTP activity.

4. Click the Commands tab.
The Command List is the list of commands that the client will execute. For the default client activ-
ity in simpleHTTP.rxf, the command list contains one command, a GET that retrieves a 4-kilo-
byte HTML page from the HTTP server activity.
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Step 6: View the Timeline and Objectives
In this step, you view the test timeline and objective.

To view the test setup:
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1. In the Test Configuration tree, click the Timelines and Objectives branch (see figure below).

The windows on this branch display the timeline (the timing of events that occur during the test,
such as when the simulated users and HTTP server are brought online) and the Test Objective.
The Test Objective is the type of goal that the test attempts to reach. For simpleHTTP.rxf, the
default Test Objective is Simulated Users, meaning that the test will attempt to simulate some
number of HTTP users using web browsers.
The Objective Value is the numerical goal for the Test Objective. For simpleHTTP.rxf, the Object-
ive Value is 100. Combined with the Simulated Users test objective, this means that the test will
attempt to simulate 100 web browsers active at one time.
The figure below shows how the test objective relates to the actions of the client and server in sim-
pleHTTP.rxf.

The Timelines tab (shown below) in the lower portion of the window contains the controls that
determine the point during the test when clients and servers begin to come online, the rate at
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which they come up (Ramp Up), the length of time they stay up (Sustain Time), and the rate at
which clients go offline (Ramp Down).

2. For the Timelines tab, accept the default values configured in simpleHTTP.rxf.

Step 7: Select Ports for the Test
In this step, you select the ports that you will use for the test and assign them to the client and server net-
works.

To select ports for the test:

1. Select the Ports node.

2. Click the Add Chassis button.
IxLoad adds a new entry to the Chassis Chain.
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3. In the new entry, type the IP address or host name of the chassis.
IxLoad connects to the chassis and adds it and its ports to the Chassis Chain. The Chassis Chain
list displays only the cards that support IxLoad.

4. In the Chassis Chain pane, click one of the ports, drag it into the Assigned Ports pane, and drop it
on one of the traffic-network mappings. Repeat for the remaining traffic-network mapping.

Step 8: Start the Test
At this point, the test is ready to run. The only remaining configuration task depends on your IxLoad
license:

To start the test:

1. In the toolbar, click the Home tab.
2. Click Start Test.
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IxLoad downloads the test configuration to the ports and then starts the test.

Step 9: View the Test Results
IxLoad displays the test results in three ways:

l In real time during the test, using StatViewer.
l After the test completes, in a PDF-format report.
l After the test completes, in a CSV file.

StatViewer
After the test starts, IxLoad automatically switches to the Statistics view, which displays the statistics from
the test (Figure 35). IxLoad uses a separate application named StatViewer to display the real-time test
statistics. When you start a test, IxLoad automatically starts StatViewer.

You can use StatViewer to select the statistics that display, to define the way that they display, to analyze
and compare statistics, and many other functions. For information on using StatViewer, see the
StatViewer User Guide.

PDF Report
After the test ends, IxLoad generates a PDF-format report that contains a summary of the test results.
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CSV Files
After a test ends, IxLoad also stores test statistics in comma-separated values (.csv) files.

The test results are available from the location defined on the User Directories window. See User Dir-
ectories.
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Each time you run a test, IxLoad creates a new directory to store the CSV and log files in; it names the
directory based on the repository name, test configuration, date and time of the test, and the activity
model and network group used. For example, the format for the client-side file is:

C:\Program Files\Ixia\IxLoad\<version>\Results\<repository>_<test con-
figuration>_<yyyy><mm><dd>_<hh><mm><ss>

An example of an actual file is:

C:\Program Files\Ixia\IxLoad\<version>\Results\simple_HTTP_Test1_
20050124_101412\HTTP_Client_-_Default_CSV_Logs_http10_HTTP_client@client_
network.csv

Step 10: Save the Test Configuration
If you want to save the test configuration and port assignments you used in the preceding steps, you
should save the simpleHTTP.rxf repository with a new name.

To save the test configuration:

1. Click the File tab.

2. Select File | Save As.
IxLoad prompts you to enter a name for the test configuration.

3. Enter a name for the repository, then click Save.
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Further Testing with IxLoad
This section contains additional sample tests that will further familiarize you with IxLoad. These tests
make use of the IxLoad test configuration (the ports you selected while using the simpleHTTP.rxf repos-
itory) created in the previous section. If you did not save that configuration, follow the steps in the pre-
vious section re-create it.

The first test described in this section adds more page requests to the existing HTTP client.

The second test adds FTP traffic to the HTTP traffic in the original test configuration.

Adding Page Requests to the HTTP Client
In this section, you add more page requests to the existing HTTP client.

To add page requests to the HTTP client:

1. In the Test Configuration tree, select the HTTP client activity.

2. Click the Commands tab.
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3. Hover the cursor over the Command list until the Add button displays.

4. In the list of Available Commands, select GET, then click Add.
IxLoad adds the GET to the command list.

5. Select the command, an it as follows:

Destination: Select HTTP server_HTTPServer1:80, the HTTP server
activity.

Page/Object: Select any of the pages listed.

Abort: Leave this set to the default, None.

NameValue Args: Leave this field blank.

6. Optionally, you can click Add again and configure additional GET commands.
7. Run the test as described in Step 8: Start the Test.
8. Follow the steps in Step 9: View the Test Results and compare the results with those from the ori-

ginal test using the one-page GET.

Adding FTP Traffic
This section describes how to add FTP traffic to the existing HTTP traffic.

To add FTP traffic to the test:
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1. In the Test Configuration tree, select the HTTP server activity.

2. Hover the cursor over the Activity list of the HTTP server NetTraffic, then click Add to add a new
activity.

3. Select FTP Server from the list of activities.

IxLoad adds a new FTP Server Activity to the HTTP server.
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4. In the Test Configuration tree, select the Client activity.

5. In the Activity list of the client NetTraffic, hover the cursor over the over the NetTRaffic until the
Add button displays, then click Add to add a new activity.

6. Select FTP Client from the list of Activities.
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IxLoad adds a new FTP Client activity to the HTTP client (as shown below).

7. In the NetTraffic, select the FTP client, then click the Command tab.
8. In the Command list, click Add to add a new command.

9. In the list of Available Commands, select {Get}, then click Add.
IxLoad adds a new {Get} command to the FTP client's command list.

10. Configure the command parameters as follows:

User Name: Enter a user name or leave this field set to its default.

Password: Enter a password (an SMTP email address) or leave this field
set to its default.

Destination: Select HTTP server_FTPServer:21, the activity that con-
tains the FTP server agent you added in the previous steps.

Arguments: Leave this field set to its default.
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11. Click Start Test to start the test.
12. Monitor the test progress and compare the results for the new test configuration that includes FTP

traffic with those for the previous test that only included HTTP traffic.

IxLoad Licenses
IxLoad is a licensed product. You do not need a license to configure a test, but you do need one to run a
test. The license must cover the protocols that you have configured for the test. Before IxLoad starts a
test, it checks for the presence of a valid license. By default, it checks for a license on the chassis selected
for the test. If your license for IxLoad is installed on a different host, use the procedure described in the
IxLoad User Guide to define the license server.

If you do not have a license for IxLoad, contact Ixia Sales (see page ii) or your Ixia sales representative.

If you have received a license for IxLoad, use the procedures described in this section to install it.

About Licensing
To install and manage Ixia licenses, you use the Ixia Registration Utility (IRU). The IRU is automatically
installed and run when you install licensed Ixia products.

Ixia’s licensing serves two functions:

l It ensures that Ixia’s software is used appropriately.
l It enables Ixia customers to centralize and monitor their software usage.

Licenses are purchased from Ixia and issued by email. These licenses must be installed onsite in order
for the licensed software to operate correctly. License installation for an Ixia software product can occur
either:

l At the time of the software installation.
l Sometime after the software installation, but before software usage.

Licenses are installed using a simple wizard process that you can run from either:

l The same computer on which the software was installed, or
l Some other Windows-based PC.

The computer used to perform the licensing process must be connected to the Ixia chassis and work-
stations in the lab environment. If at all possible, it should also be connected to the Internet. If sim-
ultaneous connections to the lab network and Internet are not feasible, it is still possible to complete all
licensing operations. The process for offline installation is covered in the License Management User
Guide.

IxLoad supports only one type of license, a node-locked license. This type of license is locked to a par-
ticular chassis or workstation and allows only certain software functions to run on that chassis or work-
station.
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Evaluation Licenses
Evaluation licenses are used to evaluate Ixia software products. They can be used for a limited number of
days. They are usually issued after a temporary license expires. They act in all respects as a regular
license (they must be installed using the IRU), save for the fact that they have a time limit.

Temporary Licenses
Temporary licenses are granted in the event that a purchased license is not yet available. This allows you
to use IxLoad even if there is a delay in obtaining a valid license.

Temporary license have a time limit (measured in days) and become invalid after the time limit expires.
They can be automatically issued when a valid license file is not found.

Prerequisites
Before installing a license, obtain the following:

l The Ixia generated registration email for the licenses being installed. The key contents of this
email are:
n A Registration Number (RN) — a unique number for the license.
n A Password — required to install the license.

l An understanding of which Ixia software products and chassis the license applies to.
l An understanding of whether a License Server is used in the Test Lab.

An example of this email is shown below in below, with the Registration Number and Password under-
lined:
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Installation Scenarios
There are four possible installation scenarios, described in the following sections:

l Licensing to a Chassis or Workstation via the Internet
l Licensing to a License Server via the Internet
l Licensing to a Chassis or Workstation without the Internet
l Licensing to a License Server without the Internet

The Installation Host is the computer that is used to perform the licensing installation. This can be the
same computer on which the Ixia software was installed, an Ixia chassis, a License Server, or a separate
workstation.
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Licensing to a Chassis or Workstation via the Internet
In this case, the Installation Host is connected to the Internet and licenses are installed to the work-
station or Ixia chassis to which the license pertains (the workstation and the Installation Host can be the
same machine). The Installation Host must also be connected to the workstation/chassis (if they are not
the same machine).

The figure below shows licensing to a Chassis or Workstation via the Internet.

Licensing to a License Server via the Internet
In this case, the Installation Host is connected to the Internet and the licenses are installed to a central
License Server (the License Server and the Installation Host can be the same machine). The Installation
Host must also be connected to the License Server and the workstation/chassis (if the License Server
and Installation Host are not the same machine).

The figure below shows licensing to a License Server via the Internet
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Licensing to a Chassis or Workstation without the Internet

In this case, the Installation Host is not connected to the Internet and the licenses are installed to the
workstation or Ixia chassis to which the license pertains (the workstation and the Installation Host can
be the same machine). The Installation Host must also be connected to the workstation/chassis (if they
are not the same machine).

In order to complete the installation process, an additional computer is necessary – an Online Host, as
shown in the figure below. This machine must be connected to the Internet. It is necessary to transfer
small amounts of information from the Online Host to the Installation Host to complete the process. E-
mail or a portable USB drive may be appropriate.

The figure below shows licensing to a Chassis or Workstation disconnected from the Internet.

Licensing to a License Server without the Internet

In this case, the Installation Host is not connected to the Internet and the licenses are installed to a
License Server (the License Server and the Installation Host can be the same machine). The Installation
Host must also be connected to the License Server and the workstation/chassis (if the License Server
and Installation Host are not the same machine).

In order to complete the installation process, an additional computer is necessary – an Online Host –
shown in the figure below. This machine must be connected to the Internet. It is necessary to transfer
small amounts of information between the Online Host and the Installation Host to complete the pro-
cess. E-mail or a portable USB drive may be appropriate.

The figure below shows licensing to a License Server disconnected from the Internet.
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General Licensing Steps
The following steps indicate the general sequence to use when installing and licensing IxLoad. These
steps assume that you will be installing the license server on your Ixia chassis. If you will be using a ded-
icated/standalone PC as a licensing server, please see the Ixia License Management User Guide for
detailed instructions. The Ixia license installation utility is included in the IxLoad CD build or download
file.

To avoid licensing problems, be careful as you proceed through the licensing utility
program. Do not just automatically click Next to proceed through the program, or
licensing will not be successful and you will not be able to use IxLoad. You must read
each installer screen and provide the requested information. Although the installer
steps walk you through the license installation process, the overview information here
is provided to ensure that you do not overlook important installation details. For more
detailed information each step, refer to the License Management User Guide.

The IxLoad installer must be run on both the Ixia chassis and the client PC. When the
installer is run on the chassis, it installs the license server component and the Aptixia
statistics engine. However, it does not install the client GUI software. When the
installer is run on the client PC, the client software is installed.

Chassis Installation
To install an IxLoad license onto an Ixia chassis:

1. Download IxLoad to your Ixia chassis from the Ixia website or the IxLoad CD.
2. Launch the installer and answer the questions as required.
3. Once IxLoad is installed on the chassis, licensing will have been installed as well.

If you already have a registration number and password, then launch the Ixia Registration Utility
(IRU) and register the software on the chassis. Make sure that your chassis is connected to the
Internet. If it is not, follow the offline registration steps in the License Management User Guide.
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If you do not have a registration number and password, you do not need to launch the IRU at this
time. A temporary license will be issued to you when you first attempt to run a test from your cli-
ent PC. At run time, a message appears, asking if you would like a temporary license. Make sure
that your client PC in connected to the Internet. If it is not, follow the offline temporary license
steps on the License Management User Guide.

4. Select register and follow the prompts that appear.
5. Accept the default localhost as the location for the features to be used.
6. When prompted with "Do you want the Ixia application to automatically find your license on the

chassis?", select Yes. If using a license server, follow the steps in the License Management User
Guide for registering on a license server.

7. Complete the license installation procedure by clicking Finish.

License Installation Example
The following example shows an online installation of a node-locked license to a local machine, with no
license server. Depending on the testing environment, other installations may have more steps.

1. If the IRU is not running, start it by selecting Start>Programs>Ixia>Licensing.
2. Click Register in the IRU, as shown in the figure below.

3. Click Start. Enter the Registration Number and Password exactly as speciin the Ixia generated
email, as shown in the figure below.
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4. Click Next. Enter the host name or IP address of the Ixia chassis or workstathat will use the
licensed software, shown in the figure below. Localhost is the default and refers to the Install-
ation Host.

5. Click Next. If a license server is used, click No and enter the name or IP address of the license
server. Otherwise, click Yes as shown in the figure below.
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6. Click Next. Review the information for the license to make sure it is accurate, as shown in the fig-
ure below.

7. Click Next. The license is installed to the workstation or chassis specified (or to the license server
if one was specified). Once the license is installed, a confirmation screen displays, as shown in the
figure below. This screen can be printed or saved as a record.
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8. Click Finish.
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